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Basic Installation

This section provides the basic steps in a typical installation of Minitab Workspace. For instructions on advanced
installation options, see Client Installation Options on page 19.

To install Minitab Workspace, follow the steps below. To renew an existing installation that has reached or is close to
reaching its expiration date, see Renewing desktop licenses on page 16.

1. Designate authorized users of multi-user desktop licensing web pages (optional).
2. Determine installation configuration.

3. Create license files at the multi-user desktop licensing web pages.

4. Obtain software.

5. Install software.

Step 1. Designate authorized users of multi-user
desktop licensing web pages

To access the Minitab Workspace multi-user desktop licensing web pages so that you can create the license files for
the installation, you must be either the Minitab License Coordinator for your organization or an authorized user.

At the time of purchase, someone from your company was designated as the Minitab License Coordinator. That person
has permission to log in to the multi-user desktop licensing web pages to create license files. In addition, your company
can have other authorized users.

If you are not sure whether you're an authorized user, contact your organization's Minitab License Coordinator. Only
the License Coordinator can request additional authorized users by contacting a Minitab sales representative or Minitab
Technical Support.

Step 2: Determine installation configuration

All multi-user desktop installations require Minitab License Manager, the software that manages Minitab Workspace
based on the information in the license file. Minitab License Manager must be installed in a configuration that allows
it to communicate with Minitab Workspace.

You can choose from several different installation configurations to suit your needs. For example, you can install Minitab
License Manager on a server in a networked configuration. In a networked configuration, users access the license file
on the server; therefore, each client computer does not need to be permanently assigned to a separate license file.
Another option is to install Minitab License Manager and Minitab Workspace on each client computer in a standalone
configuration, which requires a separate license file for each client computer.

The installation configuration you choose affects the number of license files you need to create and the installation
procedures that you need to follow. See Installation Configurations on page 8 for detailed information that will help
you to determine the best configuration for your organization.

Note To ensure compatibility with the Minitab Workspace licenses, ensure that latest version of Minitab License Manager is installed.
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Step 3: Create license file(s)

You need at least one license file for installation. To create license files, you use the Minitab multi-user desktop licensing
web pages. One license file per server is required in a networked installation. One license file per workstation is required
in a standalone configuration. See Installation Configurations on page 8 for more information on networked and
standalone configurations.

You need the following information to create a license file:

e The maximum number of simultaneous users that will be served by the license. In a standalone configuration, the
maximum number of users is 1 for each license. To determine the maximum number of users in a networked
configuration, see Number of license files on page 13.

e The MAC address of each computer that will host a license. This is the computer's physical address.

To obtain the MAC address:
1. Run the DOS command "ipconfig /all"

2. Record the physical address that appears under Ethernet adapter Local Area Connection.

3. In the example below, the MAC address of the computer is 01-23-45-AB-CD-EF.

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix.:domain.local

Description....................:Broadom NetXtreme 57XX Gigabit Controller
Physical Address............... 01-23-45-AB-CD-EF

Dhcp Enabled...................:Yes

Autoconfiguration Enabled......:Yes

IP AddressS. ..o eeeeeeeeeeenea...2192.168.1.1

Subnet Mask....................:255.255.255.0

Default Gateway................:192.168.2.100

DHCP Server.......eeeeeeeeea...:192.168.2.100

DNS Server........eeeeeeee.....:192.168.10.200

Lease Obtained.................:Saturday, December 1, 2018 4:07:19 PM
Lease Expires..................:Tuesday, December 1, 2020 4:07:19 PM

The MAC address for the network interface will be displayed in the form: xx:xx:xx:xx:xx:xx. For example, 3¢:09:3a:6¢:18:ac.
When you create your license file, enter the MAC address without the formatting characters; remove colons or dashes
(for example, 3c093a6c¢18ac).

For more information on how to obtain a computer's MAC address, see How can | locate my computer's MAC or
physical address?.

To create license files

1. Go to https://licensing.minitab.com/.
2. Login as an authorized user.

3. Complete the necessary steps to create the license file(s).

Step 4: Obtain software

All multi-user desktop configurations require both Minitab License Manager and Minitab Workspace. Download the
applications from the Minitab web site using any Minitab.com account.
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To download software

1. Go to https://www.minitab.com/downloads/.

2. Download Minitab License Manager and Minitab Workspace. The license file is read by Minitab License Manager,
the server software that manages the use of Minitab Workspace based on the information in the license file.

3. If you plan to mass deploy utilizing a software asset management tool, download the Minitab Workspace Mass
Deployment Package.

Step 5: Install software

Install Minitab Workspace and Minitab License Manager based on the installation configuration that you determined
in step 2. You can install Minitab License Manager on a server in a networked configuration or on each client computer
in a standalone configuration. For more information about client computer configurations, see Client Installation
Options on page 19.

System requirements

You can find the latest system requirements for Minitab Workspace and Minitab License Manager at
https://www.minitab.com/products/workspace/system-requirements/.

To install in a networked configuration

1. Ensure that you have administrative privileges to install Minitab License Manager on the server and Minitab
Workspace on each workstation.

2. Ensure that the license file is on the desktop of the server. See Create License File(s) on page 5 for more information.

3. Install Minitab License Manager on the server. The default installation folder can be found here.
e 64-bit version: C:\Program Files\Minitab\License Manager
e 32-bit version: C:\\Program Files (x86)\Minitab\License Manager
4. After you install Minitab License Manager, delete the license file that is on the desktop. The installation program

creates a copy of the license file in the default installation folder, and Minitab License Manager uses this license
file.

5. Install Minitab Workspace on each workstation.
® You need to specify the network name or IP address of your Minitab License Manager server during installation.

e Minitab Workspace chooses the first available port between 27000 and 27009. If your License Coordinator
specified a different port within the license file, check Specify port number, and enter that port number.

Note After you set up a networked configuration, you can use borrowing to allow a portable workstation, such as a laptop, to run Minitab
products while it is disconnected from the network. See Using Minitab products while disconnected from the network on page 8 for more
information.

To install in a standalone configuration

1. Ensure that you have administrative privileges to install Minitab License Manager and Minitab Workspace on each
workstation.
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2. Ensure that the license file is on the desktop of the workstation. See Create License File(s) on page 5 for more
information.

3. Install Minitab License Manager on each workstation.

4. After you install Minitab License Manager, delete the license file that is on the desktop. The installation program
creates a copy of the license file in the following folder, and Minitab License Manager uses this license file.

e 64-bit version: C:\Program Files\Minitab\License Manager

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager

5. Install Minitab Workspace on each workstation.
e When prompted for the name of the Minitab License Manager server, enter localhost.
e Minitab Workspace chooses the first available port between 27000 and 27009.
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Installation Configurations

The previous section explained how to install the multi-user desktop version of Minitab products. This section provides
a more in-depth explanation of the client-server model and the possible installation configurations.

Multi-user desktop installation

The multi-user desktop versions of Minitab products are based on a client-server installation model. Minitab Workspace
(the client software) is installed on individual workstations. Minitab License Manager (the server software) is installed
on a server. Every time the client software is started, it communicates with the server to ensure that a license is available.

Typically, Minitab License Manager is installed on a single server. The client software can be installed on up to three
workstations for each licensed seat. Minitab License Manager ensures that the number of concurrent users never
exceeds the licensed number of seats.

For example, an organization purchased 100 licenses of Minitab Workspace and configured Minitab License Manager
to control all 100 licenses. Minitab Workspace was installed on 300 workstations. Even though the client software has
been installed on 300 workstations, Minitab License Manager will allow only 100 instances of the client software to
run concurrently.

When the client software is started, it requests a license from Minitab License Manager. If a license is available, it is
sent to the client and the software starts successfully. If a license is not available, an error message is displayed.

Configuration options

Networked configuration

To set up a networked configuration, install Minitab License Manager on a server. A license file is requested during
the installation process. You need to provide the license file that was created during the procedure detailed in Basic
Installation on page 4 (license files should always be named "minitab.lic"). The installation program makes a copy
of the license file and places it in the installation folder.

e By default, Minitab License Manager is installed to the following folder.
o 64-bit version: C:\Program Files\Minitab\License Manager
o 32-bit version: C:\Program Files (x86)\Minitab\License Manager

e Minitab License Manager installation creates a Windows service called Minitab License Manager. The license manager
service starts automatically when it is installed. When the service starts, it checks the Minitab License Manager
installation folder for the license file. If the license file is valid, the service starts successfully.

Install the client software on as many workstations as necessary. During installation, you need to provide the network
name or IP address of the server on which Minitab License Manager is installed.

Using Minitab products while disconnected from the network

In a multi-user desktop installation of Minitab Workspace, the client software must be able to communicate with the
Minitab License Manager server to start. To allow a portable workstation, such as a laptop, to run Minitab products
when it is disconnected from the network, Minitab Workspace has a utility built into the application that allows you
to borrow a license.
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For example, you might use Minitab Workspace on a laptop when you travel for business. Before leaving, while still
connected to your company's network, borrow a license from the Minitab License Manager server. Then you can access
Minitab Workspace on the laptop when you are disconnected from the network.

To borrow a license:
1. In Minitab Workspace, choose File > Help.

2. Click Borrow License.
3. In Borrow Through, choose a return date on the calendar.

4. Click Borrow.

A borrowed license is returned automatically at the end of the borrowing period. To return a license before the end
of the borrowing period, choose File > Help and click Return License.

Note To limit the number of licenses that can be borrowed, use the options file. For an example, see Options file on page 18.

Standalone configuration

In a standalone configuration, Minitab products do not depend on accessing a network server. Instead, the Minitab
License Manager server software is installed on the same workstation as the client software, Minitab Workspace. Minitab
License Manager starts two daemons that are required to run on each standalone workstation. When Minitab Workspace
starts, it checks the Minitab License Manager service that is on the same workstation, regardless of network connectivity.
An individual license file must be created for each workstation.

Mixed configurations

You can use a combination of networked and standalone configurations. For example, you can install Minitab Workspace
on 20 workstations that are connected to the network and also install Minitab Workspace on 5 standalone workstations
that are not connected to the network.

For information on mixed installation configurations and license files, see Number of license files on page 13.

Minitab License Manager

All installation configurations for multi-user desktop licenses require the installation of Minitab License Manager, the
server software that manages the use of Minitab Workspace. Minitab License Manager ensures that the number of
concurrent users does not exceed the licensed number of seats, based on the information in the license file.

When you upgrade Minitab License Manager, choose one of the following versions.

64-bit version
minitablicensemanager2.1.0.0setup.x64.English.msi

minitablicensemanager2.1.0.0setup.x64.MultiLanguage.msi
32-bit version

minitablicensemanager2.1.0.0setup.x86.English.msi

minitablicensemanager2.1.0.0setup.x86.MultiLanguage.msi
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Property Table for Minitab License Manager

You can use the command line to install Minitab License Manager on the client computer. To do so, you must specify
the license information for each installation using the appropriate command line syntax. Use the properties in the
following table to deploy Minitab License Manager to your end users.

Property Accepted Values Description

APPDIR Specify a custom installation folder.

FILE_LOC Fully qualified path to license file, An alternative license mechanism using
including filename a file. Not intended for use with a

standalone license configuration
utilizing the Minitab License Manager.

ProductLanguage 1031 Specify the default language of the
1033 installation and application. This
1034 property can only be set within the
1036 Minitab Group Policy file. Refer to EXE
1041 Switch Table for additional language
1042 options.
1046 1031=German
2052 1033=English

1034=Spanish
1036=French
1041=Japanese
1042=Korean
1046=Portuguese
2052=Simplified Chinese

Examples

Note The following examples do not contain line breaks.

Install silently, English default language, and single-user desktop license:
minitablicensemanager2.x.x.xsetup.xXX.English.msi /qn FILE_LOC="C:\New License File Folder"

Install silently, non-English default language, and single-user desktop license:

minitablicensemanager2.x.x.xsetup.xXX.MultiLanguage.msi /gqn ProductLanguage=1041 FILE_LOC="C:\New License
File Folder"

Install silently, English default language, license file, and custom installation folder:

minitablicensemanager2.x.x.xsetup.xXX.English.msi /qn FILE_LOC="C:\New License File Folder" APPDIR="C:\New
Custom Installation Folder"

Install silently, non-English default language, license file, and custom installation folder:
minitablicensemanager2.x.x.xsetup.xXX.MultiLanguage.msi /qn FILE_LOC="C:\New License File Folder"
ProductLanguage=2052 APPDIR="C:\New Custom Installation Folder"

To restart Minitab License Manager

Minitab License Manager starts its service automatically when you install it. However, you may need to restart the
Minitab License Manager service in some cases, such as when you make changes to the license file or use an options
file.

1. Open a command prompt as an administrator and type services.msc.

2. Click Minitab License Manager.
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3. Choose Action > Restart.

Note If you need to uninstall Minitab License Manager from a computer, such as when you change servers or installation configurations,
you must first stop the license manager service. Follow steps 1 and 2 above; in step 3, choose Action > Stop. Then uninstall Minitab License
Manager.

License manager utility

Flexera Software provides a utility for performing license management tasks. You can use this license manager utility,
LMTOOLS, to check the status of Minitab License Manager and to help you monitor network licensing activities, such
as the number of licenses in use and who is using them. You can also review configuration settings. See Check Minitab
License Manager status and settings on page 26 for more information.

The license manager utility provides a graphical user interface to access all the license management tasks. To use
LMTOOLS, complete the following steps.

1. Navigate to the Minitab License Manager installation folder.
e 64-bit version: C:\Program Files\Minitab\License Manager
e 32-bit version: C:\Program Files (x86)\Minitab\License Manager

2. Double-click Imtools.exe.

For more information about the license manager utility, refer to the FlexNet Publisher License Administration Guide
distributed by Flexera Software LLC.
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License Files

License files are required for the installation of Minitab multi-user desktop products. This section provides general
background information on license files, including what they are, where they're created and stored, and how they're
used. For instructions on how to work with license files after installation, see License Manager Utility on page 11.

What is a license file?

A license file is a text file named minitab.lic. The file does not have a .txt extension, but you can open it in a standard
text editor such as Notepad. The file contains information about the licenses that your organization purchased. This
information includes the expiration date, the number of licenses, and the computer's MAC address.

After you create a license file at the Minitab multi-user desktop licensing web pages, save it to the desktop of the
computer on which you will install Minitab License Manager, the server software that manages the use of Minitab
Workspace based on the information in the license file.

Sample license file

SERVER this host OA1B2C3D4E5F

VENDOR minitab

USE_SERVER

INCREMENT Minitab minitab 19 0l-dec-2020 100 VENDOR STRING="limited \
term, limited users, borrowing enabled" DUP_ GROUP=UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO01234" SN="STDORD56789 01234INC" START=01-dec-2018 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA DICD 646D 4C9D 824B ET7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

In the sample license file above, the terms in bold specify the following information:

0A1B2C3D4E5F
The unique MAC address of the computer for which this license file was created.

Minitab
The name of the product for which the license file was created, for example, Minitab, workspace,
predictiveanalytics, or healthcare. Ensure that your product matches the product name in the minitab.lic
file and in the minitab.opt file, if the optional file is in use.

minitab
The vendor daemon name.

19
The version of the product for which the license file was created.

01-dec-2020
The expiration date of the license file.

100
The number of users allowed to concurrently run the software.

Each license file is created for a single computer. The computer is identified in the license file by its MAC address. The
license file cannot be used on a computer that does not have the MAC address specified in the license file.
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How license files are used

During the installation of Minitab License Manager, you need to provide the location of the license file. By default,
Minitab License Manager creates a copy of the license file in the following folder.

e 64-bit version: C:\Program Files\Minitab\License Manager

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager
The Minitab License Manager service is then installed. The service reads the license files and then starts.
Note After you install Minitab License Manager, you can delete the license file that is on the desktop.

Authorized users can create license files at the Minitab multi-user desktop licensing web pages. See Create license
file(s) on page 5 for more information.

Number of license files

You need one license file for each Minitab License Manager that you install. In a typical networked configuration,
Minitab License Manager is installed on a single server. In this case, only one license file is needed. For example, Minitab
License Manager is installed on a single server that will serve all 100 licenses. You need to create a single license file
for all 100 seats.

You can also divide your licenses among multiple servers, if desired. For example, Minitab License Manager is installed
on two servers, one for 75 users in Department A and the other for 25 users in Department B. This installation
configuration requires two license files: one file for 75 seats and another file for 25 seats.

In a standalone configuration, Minitab License Manager must be installed on each workstation. As a result, a unique
license file is required for each installation of Minitab License Manager. For example, a small computer training lab
has 10 computers that are not networked. You need to install Minitab Workspace and Minitab License Manager on all
10 computers. This installation configuration requires 10 license files, one for each computer.

You can have a combination of networked and standalone installations. You need to create a single license file for the
server and a separate license file for each standalone workstation. For example, an organization purchases 100 licenses
for Minitab Workspace. They want 10 standalone installations in the computer lab. A single server will host the remaining
90 licenses. This installation configuration requires 11 license files: one for the server and one for each of the 10
standalone workstations.

Adding a second product or additional users to your
license file

When you purchase a combination of products, Minitab, add-on modules, or Minitab Workspace, you must initially
create a license file for each product. However, to install the products, you need to merge the license files into one
file. After you download the license files, append the contents of one license file to the other license file.

You can also add additional users to your license, which also involves appending the contents of your new license file
to the existing file.

To append an additional product to a license file

You may need to be logged in as an administrator to perform the following steps.

1. At https://licensing.minitab.com/, create a separate license file for the additional product.
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2. Save the new license file. Do not overwrite the existing license file in the installation folder.
e 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\\Program Files (x86)\Minitab\License Manager\minitab.lic

3. Open the new license file for the additional product in a text editor.
4. Copy everything from the INCREMENT line down.
5. Close the new license file.

6. In a text editor, open the original license file from the installation folder.
e 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\\Program Files (x86)\Minitab\License Manager\minitab.lic
7. Paste the copied contents of the new license file to the end of the original license file.
8. Choose File > Save.
9. Restart the Minitab License Manager service. See To restart Minitab License Manager on page 10.

10. Verify your changes. Double-click Imtools.exe in the installation folder.
e 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager\minitab.lic

11. Click the Server Status tab, then click Perform Status Inquiry.

12. Look for the line that includes Users of product where product = the Minitab product you added to your
license. For a list of the available product names, go to How do | configure the Minitab License Manager to use an
Options file?.

Example of a license file with appended product

In the following example, product is either Minitab, workspace, predictiveanalytics,or healthcare. Ensure
that your product matches the product name in the minitab.lic file and in the minitab.opt file, if the optional file is in
use. For example, if your products are Minitab and Workspace, then the product names in the minitab.lic file should
be Minitab and workspace as shown in bold below:

SERVER this host OA1B2C3D4E5SF

VENDOR minitab

USE_SERVER

INCREMENT Minitab minitab 19 01-dec-2020 50 VENDOR_STRING:"limited \
term, limited users, borrowing enabled" DUP GROUP=UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENI01234"™ SN="STDORD56789 01234INC" START=01-dec-2018 \
SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA DICD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F Fo4d46 AC87 6C39"

INCREMENT workspace minitab 5 0l-dec-2020 8 VENDOR STRING="limited \
term, limited users, borrowing enabled" DUP GROUP=UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
RENIO1234" SN="STDORD31415 01234INC" START=01-dec-2018 \
SIGN="1EA6 00Dl E785 EEA9 F026 63B5 BBAO B8B0O CAB9 \
91CA A57A D123 D9DD 0372 A1CD 136F 12F4 ABCB EAOA 3ADY9 A7I1F \
F014 7B78 A683 6EB2 FCC6 9685 0D66 6355 441C"

To append additional users to a license file

You may need to be logged in as an administrator to perform the following steps.
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1. At https://licensing.minitab.com/, create a separate license file for the additional users.

2. Save the new license file. Do not overwrite the existing license file in the following folder.
e 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager\minitab.lic

3. Open the new license file for the additional users in a text editor.
4. Copy everything from the INCREMENT line down.
5. Close the new license file.

6. In a text editor, open the original license file in the following folder:
® 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager\minitab.lic

7. Paste the copied contents of the new license file to the end of the original license file.
8. Choose File > Save.
9. Restart the Minitab License Manager service. See To restart Minitab License Manager on page 10.

10. Verify your changes. Double-click Imtools.exe in the installation folder.
® 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager\minitab.lic

11. Click the Server Status tab, then click Perform Status Inquiry.

12. Look for the line that includes Total of x licenses issued and confirm that x is equal to the total number
of licenses (original + added).

Example of a license file with appended users

In the following example, product is either Minitab, workspace, predictiveanalytics,or healthcare. Ensure
that your product matches the product name in the minitab.lic file and in the minitab.opt file, if the optional file is in
use. For example, if your product is Minitab, then the product name in the minitab.lic file should be Minitab as shown
in bold below:

SERVER this host OA1B2C3D4ESF

VENDOR minitab

USE_SERVER

INCREMENT Minitab minitab 19 01-dec-2020 100 VENDORisTRING="limited \
term, limited users, borrowing enabled" DUP_GROUP=UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \

RENI01234" SN="STDORD56789 01234INC" START=01-dec-2018 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA DICD 646D 4C9D 824B E7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"

INCREMENT Minitab minitab 19 01-dec-2020 25 VENDOR_STRING="limited \
term, limited users, borrowing enabled" DUP_GROUP_UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \

RENIO1234" SN="STDORD31415 01234INC" START=01-dec-2018 \
SIGN="1c71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \
5B3B 0F38 C3FB DF49 1720 F1BA DICD 646D 4C9D 824B ET7A9 F724 \
3EDA 9B09 5628 733F F646 AC87 6C39"
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Renewing desktop licenses

To avoid "checkout failed" error messages that are caused by expired license files, renew your organization's Minitab
Workspace license before it expires. Minitab Workspace will not start if the license is expired.

1. Your organization's License Coordinator must purchase a new license for your organization.

2. To generate license files that have a new expiration date, an authorized user must log in at
https://licensing.minitab.com/.

e To generate license files based on your existing license configuration, click Renew (Copy) Previous File.
e To generate license files based a new license configuration, see Step 3: Create license file(s) on page 5.
3. You may need to be logged in as an administrator to perform the following steps.
a. Replace the existing license file with the new license file in the following folder.
e 64-bit version: C:\Program Files\Minitab\License Manager

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager

b. Restart Minitab License Manager. See To restart Minitab License Manager on page 10 for more information.

Specitying ports

Minitab Workspace uses two ports for communication between the workstation and the server: the license manager
(Imgrd) port and the vendor daemon (minitab) port. You can modify the license file to specify which port numbers
Minitab Workspace should use.

Specifying ports manually is useful when you need to identify them as open ports on firewalls. When communication
appears to be blocked, configure these open ports on any firewall on or between the workstation and server, including
software firewalls. See Error 96 on page 28 for more information.

You can specify both the license manager and vendor daemon ports in the same license file. Make a backup of your
license file before you edit it.

To specify a license manager port

The license manager (Imgrd) automatically chooses the first available port between 27000 and 27009 each time the
Minitab License Manager service starts. You can set this port number to a permanent value.

You may need to be logged in as an administrator to perform the following steps.

1. In a text editor, open the license file from the following folder.
e 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\\Program Files (x86)\Minitab\License Manager\minitab.lic

2. Type the port number after the MAC address on the first line. Leave a space between the MAC address and port
number, as shown in the example below step 7.

3. Save the file.

4. Restart the Minitab License Manager service to re-read the license file. See To restart Minitab License Manager on
page 10.

5. Verify your changes. In a text editor, open the Minitab License Manager log file, minitab.dl, which is located at
C:\ProgramData\Minitab\License Manager.
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6. Locate the line that includes 1mgrd tcp-port.

7. Make sure that the port number on this line is correct. For example, Imgrd tcp-port 27001.

Example of license file with specified license manager port of 27001:

In the following example, product is either Minitab, workspace, predictiveanalytics, of healthcare. Ensure
that your product matches the product name in the minitab.lic file and in the minitab.opt file, if the optional file is in
use. For example, if your product is Minitab, then the product name in the minitab.lic file should be Minitab as shown
in bold below:

SERVER this host 0A1B2C3D4E5SF 27001
VENDOR minitab
USE_ SERVER

INCREMENT Minitab minitab 19 01-dec-2020 100 VENDOR_STRING="limited \

term, limited users, borrowing enabled” DUP GROUP=UH \

ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \

NOTICE="Customer ID: 01234 License Coord ID: 56789 \

RENIO1234” SN=”STDORD56789 01234INC” START=01-dec-2018 \

SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \

5B3B 0F38 C3FB DF49 1720 F1BA DICD 646D 4C9D 824B ET7A9 F724 \

3EDA 9B09 5628 733F Fo46 AC87 6C39”

To specify a vendor daemon port

The vendor daemon (minitab) port is dynamically assigned from a wide range of port numbers each time the Minitab
License Manager service starts. You can set this port number to a permanent value.

You may need to be logged in as an administrator to perform the following steps.

1. In a text editor, open the license file from the following folder.
e 64-bit version: C:\Program Files\Minitab\License Manager\minitab.lic

e 32-bit version: C:\\Program Files (x86)\Minitab\License Manager\minitab.lic

2. Type port= and the port number at the end of the second line ("port" is case-sensitive). Leave a space between
minitab and port=.

3. Save the file.

4. Restart the Minitab License Manager service to re-read the license file. See To restart Minitab License Manager on
page 10.

5. Verify your change. In a text editor, open the Minitab License Manager log file, minitab.dl, which is located at
C:\ProgramData\Minitab\License Manager.

6. Locate the line that includes minitab using TCP-port.

7. Make sure that the port number on this line is correct. For example, minitab using TCP=port 3000.

Example of license file with specified vender daemon port of 3000:

In the following example, product is either Minitab, workspace, predictiveanalytics, of healthcare. Ensure
that your product matches the product name in the minitab.lic file and in the minitab.opt file, if the optional file is in
use. For example, if your product is Minitab, then the product name in the minitab.lic file should be Minitab as shown
in bold below:

SERVER this_host OA1B2C3D4ESFE
VENDOR minitab port=3000
USE SERVER
INCREMENT Minitab minitab 19 01-dec-2020 100 VENDOR_STRING="limited \
term, limited users, borrowing enabled” DUP GROUP=UH \
ISSUER=Minitab ISSUED=01-dec-2018 BORROW=26280 \
NOTICE="Customer ID: 01234 License Coord ID: 56789 \
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RENI01234” SN=”STDORD56789 01234INC” START=01-dec-2018 \
SIGN="1C71 F7B8 641F 7A84 F052 9650 F5E6 B093 ACBC 04C4 AF4D \

Options file

You can use the options file to control various license system options for Minitab License Manager, such as reserving
or excluding licenses for a person or group.

To use an options file

You may need to be logged in as an administrator to perform the following steps.
1. In a text editor, open a new file.

2. Type your settings with the appropriate syntax, as documented in the FlexNet Publisher License Administration
Guide distributed by Flexera Software LLC. See the bottom of this topic for an example options file.

3. Choose File > Save As and browse to the same folder as minitab.lic.

e 64-bit version: C:\Program Files\Minitab\License Manager

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager

4. Save the file with the following file name: minitab.opt
5. Restart the Minitab License Manager service. See To restart Minitab License Manager on page 10.

6. Verify that the options file is successfully implemented. In a text editor, open the Minitab License Manager log file,
minitab.dl, which is located at C:\ProgramData\Minitab\License Manager.

7. Locate the line that includes Using options file:<path to options_ file>. If this text is present, the
options file has been successfully implemented.

If a minitab.opt is present, the Minitab License Manager service reads it and implements the settings in the file.

In the following example of an options file, line 1 prevents the user "tjones" from using Minitab. Line 2 prevents the
same user from using Minitab Workspace. Line 3 creates a group named "quality" and defines members of that group.
Line 4 reserves three licenses for the quality group. Line 5 specifies that 5 licenses cannot be borrowed. Line 6 identifies
the 5 users that are able to access the Predictive Analytics Module.

EXCLUDE Minitab USER tjones

EXCLUDE workspace USER tjones

GROUP quality jsmith bmiller awilson

RESERVE 3 minitab GROUP quality

BORROW LOWWATER minitab 5
INCLUDE predictiveanalytics USER abesoe bcarmel cduxelle depson efesler
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Client Installation Options

After you install, configure, and license the software, you can install the client.
e Choose Activate with a license (Sign in, Product Key, License Server, or License File).

e Optionally, change the destination folder. By default, Minitab Workspace is installed to C:\Program Files
(x86)\Minitab\Minitab Workspace.

Checking for updates

Checking for updates is enabled by default. An automatic check occurs upon every launch of the product, and each
user is able to manually check for updates at any time. You can set an optional property during deployment to disable
checking for updates. See Deploying Minitab Workspace on page 19 for additional details.

To manually check for updates
1. Open Minitab Workspace.
2. Choose Help > Check for Updates.

3. If an update is available, follow the instructions to update your software.

To disable checking for updates

1. Open a command prompt as an administrator and type control appwiz.cpl.

2. Select Minitab Workspace and then click Uninstall/Change. You might be prompted for an administrator password
or confirmation.

3. In the Minitab Workspace Setup dialog box, select Change.
4. Uncheck Enable checking for software updates.

5. Click Next, and then click Install.

Note If you choose to remove or disable checking for updates, you will not be automatically informed of critical updates, bug fixes, or
notifications of problems or errors.

Deploying Minitab Workspace

You can use the command line to install Minitab Workspace on the client computer. To do so, you must specify the
license information for each installation using the appropriate command line syntax. The following tables outline
properties and switches that can be used for command line or mass deployment to your end-users.
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EXE Switch Table

Command Line Switch

/exelang 1031
1033
1034
1036
1041
1042
1046
2052

/exenoui

MSI Switch Table (Common)

Command Line Switch
/passive

/an

/qb

/qr

Property Table

Property
APPDIR

ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT

LICENSE_SERVER

Minitab B’

Accepted Values

Client Installation Options

Description

Specify the default language of the
installation and application. If language
is not specified, the installer will use
your system regional settings for the
default language, or default to English
if a match is not found.
1031=German

1033=English

1034=Spanish

1036=French

1041=Japanese

1042=Korean

1046=Portuguese

2052=Simplified Chinese

Required for a silent install. Use with
appropriate MSI switch for modified
end-user experience (e.g., /qn, /qb,
/passive).

Description

Basic user interface, progress bar only

Quiet, no user interface

Basic user interface, the Cancel button will be active during

installation

Reduced user interface, the Cancel button will be active

during installation

Accepted Values

Server name or IP address

Description

Specify a custom installation
folder.

Required property. By specifying
a value for this property, you
accept the terms of the software
subscription agreement and
privacy notice.

For use with a multi-user desktop
license to specify the server that
hosts Minitab License Manager.

e Not compatible with
PRODUCT _KEY,
LICENSE_PORTAL, or FILE_LOC
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Property
LICENSE_SERVER_PORT

PRODUCT_KEY

FILE_LOC

LICENSE_PORTAL

Minitab B’

Accepted Values
27000 to 27009

18-digit Product Key

Fully qualified path to
license file, including
filename

Client Installation Options

Description

For use with a multi-user desktop
license to optionally specify the
listening port for the Minitab
License Manager server.

Single-user desktop licenses can
be activated by specifying a
Product Key.

e Not compatible with
LICENSE_SERVER,
LICENSE_SERVER_PORT,
LICENSE_PORTAL, or FILE_LOC

An alternative license mechanism
using a file. Not intended for use
with a standalone license
configuration utilizing the
Minitab License Manager.

e Not compatible with
LICENSE_SERVER,
LICENSE_SERVER_PORT,
LICENSE_PORTAL, or
PRODUCT_KEY

e Corresponds to the location
of your minitab.lic file

For use only with online accounts
that require sign-in.

e Not compatible with
LICENSE_SERVER,
LICENSE_SERVER_PORT,
PRODUCT_KEY, or FILE_LOC
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Property
DISABLE_ANALYTICS

PERSONAL_FOLDER

WORKGROUP_FOLDER

Minitab B’

Accepted Values
Oor1

A path to a location on the
user's computer

A path to a commonly
accessible location, such
as a network folder

Client Installation Options

Description

With consent, Minitab collects
analytics to understand customer
needs.

Examples

e Product information
(imported file types, tools,
commands, and frequency of
use)

e Project characteristics
(amount of data, number of
worksheets, and frequency
and duration of use)

e Performance information (any
issues encountered while
using Minitab products
and/or services)

Minitab does not collect
user-entered data or statistical
results.

Settings

Enter a value now or when you
launch the software.

e Enter 0 to enable analytics

e Enter 1 to disable analytics

If you deploy software for end

users, the following settings

apply.

e 0 allows end users to enable
or disable analytics on their
computers

e 1 disables analytics for all end
users

These settings do not prevent
Minitab from collecting other
types of data from its websites
and products, such as the data
required to manage licenses or
access online Help. For more
information, view our privacy
notice.

The location where personal
templates are stored. By default,
the Personal folder is located in
the user's Application Data folder.

The location where shared
templates are stored. The
Workgroup folder does not have
a default value.
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Property Accepted Values Description

ProductLanguage 1031 Specify the default language of
1033 the installation and application.
1034 This property can only be set
1036 within the Minitab Group Policy
1041 file. Refer to EXE Switch Table for
1042 additional language options.
1046 1031=German
2052 1033=English

1034=Spanish
1036=French
1041=Japanese
1042=Korean
1046=Portuguese
2052=Simplified Chinese

DISABLE_UPDATES 1 When you specify a value for this
property, you turn off the ability
to check for software updates.
Disabling this option prevents
automatic and manual checks
from occurring. We recommend
that you enable this option on at
least one computer.

e Set LICENSE_PORTAL=1 to
manage updates through the
License Portal.

Command Line Details
1. You must use the /exenoui switch when you use /qn, /gb, or /passive.

2. Verify that command line switches are in correct order.
e EXE switches must precede MSI switches.
e MSI switches must precede MSI properties.

3. If you do not specify licensing properties (LICENSE_PORTAL, PRODUCT_KEY, LICENSE_SERVER, or FILE_LOC), the
free trial will be installed.

4. If you have a previous version of Minitab Workspace installed, the existing values will be used for APPDIR,
LICENSE_PORTAL, LICENSE_SERVER, LICENSE_SERVER_PORT, and PRODUCT_KEY, if they are not specified during
the upgrade.

Required Syntax

Use the following syntax: productV.v.v.vsetup.exe, where
e Lowercase product is the name of the software,
e Uppercase V indicates the major release number of the software; and

e Lowercase v (up to 3) indicates an update to the major release of the software.

For example: minitabworkspace1.4.2setup.exe [EXE Switch Table] [MSI Switch Table] [Property Table]
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Examples

Note The following examples do not contain line breaks.

Install silently, English default language, account sign-in:
productV.v.v.vsetup.exe /exenoui /exelang 1033 /gn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1
LICENSE_PORTAL=1

Install silently, German default language:
productV.v.v.vsetup.exe /exenoui /exelang 1031 /qn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1

Install silently, English default language, multi-user desktop license:
productV.v.v.vsetup.exe /exenoui /exelang 1033 /qn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1
LICENSE_SERVER=MyServerName

Install silently, English default language, multi-user desktop license setting server and port, setting workgroup
and personal templates folder, and checking for updates disabled:
productV.v.v.vsetup.exe /exenoui /exelang 1033 /qn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1
LICENSE_SERVER=MyServerName LICENSE_SERVER_PORT=27000 WORKGROUP_FOLDER=\\serverT\workgroup
PERSONAL_FOLDER=C:\templates DISABLE_UPDATES=1

Install silently, English default language, license file:
productV.v.v.vsetup.exe /exenoui /exelang 1033 /qn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1
FILE_LOC="C:\minitab.lic"

Install silently, English default language, single-user desktop license with product key, and custom installation
folder:
productV.v.v.vsetup.exe /exenoui /exelang 1033 /qn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1
PRODUCT_KEY=123456789012345678 APPDIR="C:\New Custom Installation Folder"

Upgrade Minitab Workspace silently:
productV.v.v.vsetup.exe /exenoui /qgn ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1

Uninstall silently using the Minitab Workspace product code:
msiexec /x {Product Code} /gn

Product Code Registry Location:
[HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Windows\CurrentVersion\Uninstall\Minitab
Workspace V.v.v.v]

String: UninstallPath

Group policy usage

The MSls in the GroupPolicy folder of the Mass Deployment Package should be used only for Group Policy deployment

methods. Use the Group Policy MSIs in conjunction with repackaging tools to ensure that Properties are set correctly

for the required configuration.

e To install Minitab Workspace with English as the default language, use productV.v.v.vsetupGroupPolicy.English.msi.

e To install Minitab Workspace with a non-English default language, use
productV.v.v.vsetupGroupPolicy.MultiLanguage.msi.

The ProductLanguage property must be set to a supported language value. For a list of supported language values,
refer to the Property Table.
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Changing license types

A valid license is required to use Minitab Workspace. There may be times when it is necessary to switch from one
license type to another. For example, you change your license type when you switch from a trial license to a multi-user
desktop license utilizing a license server.

To change license type for Minitab Workspace:

1.
2.
3.
4.

Open Minitab Workspace.
Choose Help.
Under License Information, select Change License Type.

Select the appropriate license type and enter the required licensing information.

If you get an error when you open Minitab Workspace, select Change License Type in the licensing dialog to change
the currently installed license type.
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Troubleshooting

This section provides information for troubleshooting problems related to licensing and installing Minitab products.

Log files

You can generate log files to use for troubleshooting with both Minitab Workspace and Minitab License Manager.

Installation log file

The installation log file contains information such as the time and date of installation and the folder to which the
software was installed. An installation log file can be created by utilizing the following command: productV.v.v.vsetup.exe
/exenoui /gn /I*v C:\install.log ACCEPT_SOFTWARESUBSCRIPTIONAGREEMENT=1 LICENSE_SERVER=MyServerName

Minitab License Manager log file

Minitab License Manager is the server software that controls the use of your license. It generates a log file that is

updated with events, such as license check-ins, check-outs, and error messages. The log file is named minitab.dl and

is located in a hidden folder at C:\ProgramData\Minitab\License Manager.

e To find the Minitab License Manager log file, show hidden items.

e To read the Minitab License Manager log file, open it in a text editor.

e To reset the size of the Minitab License Manager log file (for example, when it gets too large), restart Minitab
License Manager. For more information, see To restart Minitab License Manager on page 10.

Note Fordetailed information on the Minitab License Manager log file, refer to the FlexNet Publisher License Administration Guide distributed
by Flexera Software LLC.

Check Minitab License Manager status and settings

You can check the status of Minitab License Manager to help you monitor network licensing activities, such as the
number of licenses in use and who is using them. You can also review configuration settings.

1. Navigate to the Minitab License Manager installation folder.

e 64-bit version: C:\Program Files\Minitab\License Manager

e 32-bit version: C:\Program Files (x86)\Minitab\License Manager
2. Double-click Imtools.exe.

3. Do any of the following:
¢ To check server status, click the Server Status tab. Click Perform Status Enquiry.
e To check server configuration, click the Config Services tab.

e To check license information, click the Server Diags tab. Click Perform Diagnostics.

The number of licenses are listed, as shown in this example:

Users of workspace: (Total of 50 licenses used; Total of 33 licenses in use)

Specific details about each license are also listed:
jsmith LAB PC (v1.0) (LAB_PC/27000 302), start Fri 3/1 4:15
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jsmith is the user name, LAB_PC is the computer name, and 27000 is the license manager port

Borrowed licenses display the expiration in seconds. For example, the license below will expire in 314159 seconds:

jsmith LAB PC (v1.0) (LAB PC/27000 302), start Fri 3/1 4:15

FlexNet license errors

(linger: 314159)

You may encounter several types of FlexNet error messages that indicate that you cannot check out a license. These

messages are formatted in general as follows:

FLEXNET License Error Number: Error text.

For example:
FLEXNET License Error -97-121-0:

Check out failed.

Some of the errors that you may encounter are listed below. For a complete list of possible error codes, see the FlexNet

Publisher License Administration Guide.

Error 15

Possible cause

The server name that was provided during the installation
of Minitab Workspace on the client computer is not valid.

Error 25

Possible cause

You are using Minitab Workspace with an invalid license
file.

Error 34

Possible cause

The date differs in excess of 24 hours between the client
computer and the Minitab License Manager server.

Minitab B’

Explanation

The server name that was provided during the installation
of Minitab Workspace on the client computer is used to
locate that server on the network. Make sure that the server
name is valid. For instructions on locating the server name,
see Can | change the default location where my software
looks for the License Manager?.

Explanation

The license file that is managed by Minitab License
Manager supports some other Minitab product. To resolve
this, you need to create a new license file for Minitab
Workspace.

Explanation

If the date difference is greater than 24 hours, Minitab
License Manager will refuse to grant the license. Reset the
clock on the client computer.
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Error 68

Possible cause

The license file is not configured to allow for borrowing.

Error 92

Possible cause

The MAC address in the license file does not match the
MAC address of the Minitab License Manager server.

Error 95

Possible cause

You are browsing to a license file in a standalone
configuration.

Error 96

Possible cause

Firewalls or network configurations are blocking
communications between the client computer and the
Minitab License Manager server.

The Minitab License Manager service is not running on the
license server.

Error 97

Possible cause

The MAC address in the license file does not match the
MAC address of the Minitab License Manager server.

Minitab B’
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Explanation

Not all licenses are borrow-enabled. Borrow-enabled
licenses will have "borrow-enabled" within the text of the
license file.

Explanation

The MAC address in the license file must match the MAC
address of an enabled network adapter on Minitab License
Manager. See License Files on page 12 for more
information.

Explanation

Your license type may not support this method. In the Find
License dialog box, instead of choosing Specify the
License File, choose Specify the License Server System.
Type the server name. For example, type @localhost.

Explanation

The client computer must be able to communicate with
the Minitab License Manager server over two ports: the
Minitab License Manager (Imgrd.exe) port and the minitab
vendor daemon (minitab.exe) port. You can use telnet to
test communications. See the Minitab License Manager
log file on page 26 to determine which port numbers are
used. See Specifying ports on page 16 to manually
configure ports.

The Minitab License Manager service must be running to
process license requests for Minitab Workspace.

Explanation

The MAC address in the license file must match the MAC
address of an enabled network adapter on Minitab License
Manager. See License Files on page 12 for more
information.
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Possible cause

The license expired.

The network adapter on the Minitab License Manager
server is disabled.

The license file was modified.

The date is incorrect on the computer that runs Minitab
License Manager software.

Minitab License Manager is installed to C:\FlexLM\Minitab.

The Minitab License Manager service is not running on the
license server.

Minitab License Manager is using a different
communication port than expected.

Error 104

Possible cause

You attempt to borrow a license that is past either the
expiration date in the license file or a set limit in the
options file.

Troubleshooting

Explanation

The expiration date for your license is specified in the
license file. Minitab Workspace is not usable after the
expiration date. See License Files on page 12 for more
information.

The network adapter card must be enabled for the Minitab
License Manager server to verify the MAC address. Without
this, Minitab Workspace cannot start. This issue is most
commonly encountered with laptop computers that may
change the status of a network card under various
conditions.

You can make a few valid changes to the license file, such
as specifying a port number. Most other changes will
corrupt the license file, making it unusable to Minitab
License Manager.

Minitab installations are sensitive to the computer's date.

Minitab License Manager should not be installed to this
folder. Uninstall Minitab License Manager and install to a
different folder.

The Minitab License Manager service must be running to
provide license requests for Minitab Workspace.

Multiple FLEXIm license managers may be running on this
server, which caused the Minitab License Manager to use
a different port. See To specify a license manager port on
page 16 to manually configure ports.

Explanation

You cannot borrow a license that is past the expiration
date of the license file. If the specified end date for
borrowing is before the expiration date, the options file
may contain limits on borrowing. See Options file on page
18 for more information.

Minitab License Manager fails to start

If the Minitab License Manager service fails to start, you may see the following error message:

The Minitab License Manager service on Local Computer started and then stopped. Some services stop automatically
if they have no work to do, for example, the Performance Logs and Alerts Services.

Use the following table to troubleshoot the problem:
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Possible cause

The license file (minitab.lic) is not in the Minitab License
Manager installation folder.

Troubleshooting

Explanation

Minitab License Manager browses to the default
installation folder for the license file. Ensure that

minitab.lic is in the following folder.

e 64-bit version: C:\Program Files\Minitab\License
Manager

e 32-bit version: C:\Program Files (x86)\Minitab\License
Manager

The license file must be named "minitab.lic" (unless this
default value was modified later). Make sure that the file
is not named minitab.lic.txt (a common mistake). Confirm
that the file does not end with .txt. Right-click the file,
choose Properties, and verify that Type of file is License
and not Text Document.

The license file is not named correctly.

Extra text is in the license file. Some text editors, such as WordPad, may add unwanted
content to your file. See Sample license file on page 12
for an example of a license file with no unnecessary text.

Open the file in Notepad.

Minitab License Manager does not have permission to write By default, Minitab License Manager creates minitab.d|

the log file (minitab.dl) to the folder specified in the Config in C:\ProgramData\Minitab\License Manager. You can

Services tab of LMTOOLS. specify a different folder with LMTOOLS (Imtools.exe).
Make sure that the account that runs the Minitab License
Manager service has write access to this folder.

The Minitab License Manager server has non-ANSI characters For best results, install Minitab License Manager to a
in its name. computer with only ANSI characters in its name.

Web site errors

Access Denied

If you try to log in to the Minitab multi-user desktop license management web pages and you are not an authorized
user, the Access Denied error message may appear. For more information, see Step 1: Designate authorized users of
multi-user desktop licensing web pages on page 4.

Unable to Proceed: Entitlements Not Available

If you log in to the multi-user desktop license management web pages to create license files and there are no valid
orders for your organization, the message Unable to Proceed: Entitlements Not Available appears.
Contact your Minitab Sales Representative.

Online resources

The following online resources are available:

e Troubleshooting solutions at https://support.minitab.com/installation/
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e The latest downloads for Minitab multi-user desktop products at https://www.minitab.com/downloads/

e The latest documentation for Minitab multi-user desktop products at
https://www.minitab.com/support/documentation/

e The FlexNet Publisher License Administration Guide distributed by Flexera Software LLC at
https://www.minitab.com/uploadedFiles/Documents/license-management/FlexNetLicenseAdminGuide.pdf
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